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1. Introduction to Ellucian Banner INB
The purpose of this guide is to introduce the learner to the basic functions of Ellucian Banner
INB including navigation, name searching, record query, and record updates.
Banner is an integrated internet-native database application that is comprised of six major
product modules. Each product module has application sub-modules.
1. Student
2. Advancement
3. Finance
4. Human Resources – Payroll/Position Control
5. Financial Aid
6. General
All information is stored in a single database and is accessed according to need through the
different modules.
For example, a Kent State University employee who is also a student and an alumnus will have
a record in the Human Resources system, the Student system, the Advancement system and
possibly the Finance system. Storing this information in four separate systems would lead to
outdated, inaccurate information and in poor data integrity. In Banner, when the employee’s
address is updated, the correction is shared by the other modules.
Ellucian is the name of the company that owns the Banner product suite.
Banner is the name of the ERP or enterprise resource planning database system.
Banner INB is the ‘core’ database system, used to view and update records.
INB stands for Internet Native Banner, which means it is a web application.
There are other modules in the Banner product suite, including:
Luminis web portal, branded as ‘FlashLine’ at KSU
Banner Self Service, branded as ‘FlashFast’ at KSU
Banner Workflow
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2. Access Banner INB

STEP

ACTION

1.

Log in to FlashLine at ww.kent.edu or your campus homepage.

2.

Locate and click on the My Action Items tab.

3.

Locate the My Banner channel.
Click the link Banner INB.

If Banner does not accept your ID and password, contact your supervisor.
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3. Parts of the Main Menu (GUAGMNU)

1.

Menu Bar - Offers a variety of options for navigating within Banner.

2.

Toolbar - Icon shortcuts to perform common functions.

3.

Title Bar - Displays the form name and seven-character code, the instance of Banner
(Production, Test, or Training), the version of Banner in use, and the date.)

4.

Go To Field - Quickly access a form by typing the form's seven-character code.

5.

Banner Folder Menu - Access forms by selecting and opening folders.

6.

Broadcast Message - A message is sent to all Banner users by the system administrator.

7.

Auto Hint/Status Line - Displays error and processing messages and hints for use.

8.

My Links - Create up to six links to favorite URLs or frequently-used Banner forms.
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4. Banner Form Names
Every form in Banner has an abbreviated 7-character form name, and forms are often referred
to by this name. Each character describes the form function.
The first letter identifies the product module which owns the form, report, process or table:
CODE PRODUCT
A

Advancement

F

FINANCE

G

GENERAL

N

POSITION C ONTROL

P

PAYROLL

R

FINANCIAL AID

S

STUDENT

T

ACCOUNTS RECEIVABLE

The second letter identifies the application module owning the form, report, process or table.
It is also unique to the product identified by the first letter. (See separate handout.)
The third Letter identifies the type of form. These codes are the same for all Product modules.
Letters 4 - 7 comprise a unique four-character code for the form, report, process or table.
Examples
CODE

PURPOSE

SPAIDEN

Student, Person, Application, Identification form

SPATELE

Student, Person, Application, Telephone form

GUAIDEN

General, Utility, Application, Identification form

SFASPRO
form

Student, Registration, Application, Permission/Override

What can I do with a form? If you see the letter Q after the form name in the form title bar,
You have query-only access to the form. You can view the form data and perform queries, but
you do not have permission to change or delete data using this form.
If there is no letter Q after the form name, you have the ability to update data using the form.
This includes changing data, and adding and deleting records.
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5. Open a Banner Form
You will use forms to enter and look up information stored in the database. Think of a form as
a window into the database.

5.1. Open a form from the Main Menu

Go To Field - Type the seven-character form code and press the Enter key.
Banner Folder menu – Double-click to open folders and find the form that you wish to access.
Double-click on a form to open the form.
Personal Links – After you have saved links to frequently-used forms, click on a link to
open a form.
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5.2. Open a form from within a Form
Select File Menu—Direct Access or press the F5 key.
The Go To field opens. Type the name of a form and press the Enter key.

Banner retains a list in the File Menu of the last 10 forms that were accessed
during the current Banner session. Click on a form name in the list to re-open the form.
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6. Parts of Banner Forms
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1.

Menu Bar - Provides a variety of ways to navigate, query, enter information,
and access help functions.

2.

Tool Bar - Contains icons used to navigate in Banner and provides other functions.

3.

Title Bar - Displays the form’s descriptive name, the seven-character ID name,
the software version number and the database name.

4.

Key Block - Where you start on a form. Almost every form has a Key Block that
contains information that determines displayed in the remainder of the form.

5.

Radio Button - Similar to a Check Box, except one of the choices must be enabled.

6.

Date Field - Used to display dates for particular occasions, such as birthdate
or date a record was updated.

7.

Check Box - An indicator that can either enabled (checked) or disabled (not checked).

8.

Pull-Down List - Used to select a field value from a list of pre-defined values.

9.

List of Values - A table of codes and descriptions that can be customized to meet the
University’s standards. A list of values will appear when you choose this option by
clicking on the search button.

10.

Information Block - Displays data about the information entered in the Key Block.
This area is where information is entered prior to updating a record. A form can
have multiple Information Blocks.

11.

List of Values - A sample of the table of codes.
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6.1. Menu Bar Components
FILE MENU

Direct Access - Access a form without leaving the current form (Keystroke=F5).
Object Search - Use to locate a form, job, or QuickFlow.
QuickFlow - Displays the QuickFlow Form which is used to access a QuickFlow.
Select - Enters the selected value into a field.
Rollback - Returns you to the Key Block (Keystroke=Shift-F7).
Save - Saves all changes entered since the last time you saved (Keystroke=F10).
Refresh - Clears the message line; redraws the screen.
Print - Prints the current window.
Exit - Exit form.
Exit QuickFlow - Closes your QuickFlow.
Preferences - Displays the Personal Preferences Maintenance Form (GUAUPRF)
which is used to customize Banner for individual users.
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6.2. Edit Menu

Cut - Cuts selected text and places it on the clipboard (Keystroke= Ctrl-X).
Copy - Copies selected text and places it on the clipboard (Keystroke=Ctrl-C).
Paste - Pastes text from the clipboard to the cursor location (Keystroke=Ctrl-V).
Edit - Displays the editor window, which is used to enter and update text.

6.3. Options Menu
NOTE: The Options Menu varies from form to form. Some take you to other blocks and
windows within the current form, other options take you outside the current form.
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6.4. Block Menu

Next - Moves cursor to the next block that has at least one enterable field. You must Next
Block to leave the Key Block (Keystroke=Ctrl-Page Down).
Previous - Moves cursor to the previous block that has at least one enterable field. This
feature will not take you back to the Key Block (Keystroke=Ctrl-Page Up).
Clear - Clears all information in the current block, also known as Enter Query; puts the form in
Query Mode (Keystroke=F7).

6.5. Item Menu

Previous - Moves the cursor to the previous enterable field (Keystroke=Shift-Tab).
Next - Moves the cursor to the next enterable field (Keystroke=Tab).
Clear - Clears all information from the current field on your display; however, it does not
remove information from any record or table.
Duplicate - Duplicates the contents of the same field in the previous record and copies it into
the new record. Used in blank row of a repeating record.
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6.6. Record Menu

Previous - Moves cursor to the first enterable field in the previous record
(Keystroke=Up Arrow).
Next - Moves cursor to the first enterable field in the next record of the current block. If the
cursor is in the last record, a new record is created (Keystroke=Down Arrow).
Scroll Up - Scrolls up the list of repeating records, putting the first displayed record at the
bottom of the list (Keystroke=Page Down).
Clear - Clears all information from the display of the current record.
Remove - Removes all information for the current record. When you save, the record is
permanently deleted.
Insert - Inserts a new blank record in the existing records.
Duplicate - Duplicates the content of all fields in a record and copies them into a new record.
Lock - Temporarily locks the contents of the record so no other Banner user can update it
(Save, Rollback then Exit releases the lock).
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6.7. Query Menu

Enter - Puts the form into Query mode so you can enter search criteria to retrieve
information already in the database (Keystroke=F7).
Execute - Searches the database and displays records that match your search criteria
(Keystroke=F8).
Last Criteria - Enters the criteria from your last search
((enabled only when you are in Query Mode) (Keystroke=F7 twice)).
Cancel - Cancels the Query and takes the form out of Query mode (Keystroke=Ctrl-Q).
Count Hits - Counts the number of records that match the search criteria and displays that
number on the Auto Hint line.
Fetch Next Set - If more records meet the search criteria that fit in the window, clicking this
option replaces the current set of displayed records with the next set.

6.8. Tools Menu
Used for specific features of Xtender Image Database Solutions and Workflows.
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6.9 Help Menu

Online Help - Displays online information for Banner forms, windows, blocks and fields
(Keystroke=Ctrl-H).
Dynamic Help Query - Displays the Dynamic Help Form (GUAHELP) in Query mode, which is
used to display traditional help for a field, block or form.
Dynamic Help Edit - Displays the Dynamic Help Query Form (GUAHELP) in Edit mode, which
is used to edit traditional help for a field, block or form.
Help (Item Properties) - Displays the Oracle item properties window for the current
field. The window lists properties such as internal database name, type of data,
maximum length, etc.
Show Keys - Displays the list of functions and their equivalent keystrokes available in your
environment for the current form, window, or field (Keystroke=Ctrl-F1).
List - Displays the List of Values (LOV) for the current field if List of Values appears in the
Status line (Keystroke=F9).
Display Error - Displays the code that is in error, if an Oracle error occurs (Keystroke=Shft-F1).
Display ID Image - Displays the image associated with the ID, if available, when the cursor is
an ID field.
Calendar - Displays the calendar.
Calculator - Displays the calculator.
Extract Data With Key - Extracts Banner data (for the current block), along with Key data,
for use in a spreadsheet. This is available only from certain forms.
Extract Data No Key - Extracts Banner data (for the current block), without Key data, for use
in a spreadsheet. This is available only from certain forms.
Technical Support - Options that allow you to work with ACS if you are experiencing
problems with Banner.
About Banner - Displays the About Banner Form (GUAABOT), which identifies the current
form, release number, date and time.
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6.10. Toolbar Components
A toolbar is a set of icons that represent shortcuts for performing common functions.

Save (F10)

View/Send Message

Rollback (Shift-F7)

Print (Shift F8)

Select (Shift-F3)

Banner Xtender Solutions

Insert Record (F6)

BXS - Add Document

Remove Record (Shift-F6)

Workflow Submit

Previous Record (Up Arrow)

Workflow Release

Next Record (Down Arrow)

Broadcast Message

Previous Block (Ctrl-Page Up)

Fine Grain Access

Next Block (Ctrl-Page Down)

Multi-Institution
(not enabled)

Enter Query (F7)
Execute Query (F8)

Online Help (F1)

Cancel Query (Ctrl-Q)

Exit (Ctrl-Q)
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7. Record Search and Form Navigation
7.1. Open a Record When You Know the ID or Correct Name

STEP ACTION
1.

Type the ID or name, press Tab or Enter.

2.

If a match is found, both the ID and name field will fill in.

3.

Click Next Block

to populate the rest of the form with data

7.2. Next Block and Rollback
STEP ACTION
1.

Remember to always click Next Block
(or Ctrl-PageDown.)

to populate the form with data.

2.

To return to the Key Block to search for another record, click the Rollback button.
The ID will be highlighted. Type a new ID, or press delete and Tab to search again.

7.3. Open a Second Form with Direct Access

Step
1.

Action
Open a second form to check detail, and then close it, returning to your original form.
Do not open multiple forms and leave them open, as this can generate display errors.

2.

Click the File menu, select Direct Access to display the Go To... field. (Or click F5)

3.

Type the name of another form in the Go To... field and press Tab or Enter.

4.

When the form opens, Next Block to view the data.

5.

Exit

the second form when you are done, returning to the first form.
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7.4. Find a Record when Multiple Names Are Returned
names
retrieved

# records

STEP

ACTION

1.

The ID and Name Extended Search form will pop up when there is more than one
person in the Banner database under the name you typed.

2.

Click the Results menu button
to view other records retrieved.
The Person/Non-Person Count Field shows how many records were matched.

3.

If you can tell which record matches the person you are looking up,
double-click on the name in the Results list to open the record.

4.

If there are too many names, you must reduce the search results.
Specify a City, State, Zip code, Birth Date, or Gender.
You may use a combination of these search criteria.

5.

Click the Reduce Search icon
have been specified.

to re-run the search with the limitations that
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7.5. Search for a Record Using SOAIDEN and Query

STEP

ACTION

1.

Click the ID field Search button to open the search Option List.
Non-Person: department, vendor, or other entity. Alternate ID: search by SSN.

2.

Click Person Search. The SOAIDEN form will open and present a query grid.

Smith
STEP

ACTION

1.

Type whatever accurate information you have into the fields.
If you are not sure of the spelling of an item, leave the field blank.

2.

Press the F8 key to execute the query.
Review the results. You may have to use the scroll bar at the right side of the
page to scroll through all of the names listed.

3.

Press F7 to clear a query and type a new query.

4.

Press F7 to clear a query and type a new query.

5.

The query screen will close, opening the record in the form where you started.
Next Block to see record details.
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7.6. Search for a Record Using Detail form SOAIDNS

STEP

ACTION

Note: If your search retrieved several similar names, and you cannot determine the correct match,
you can quickly view more information about each person, in order to pinpoint the correct record.
1.

From the SOAIDEN query results screen (see 6 above) highlight a single record, then
from the Options menu select Search and Display more Detail.

2.

SOAIDNS will open with the name you highlighted in the first block.
Click F8 to populate the form, retrieving the address and curriculum information.
Scroll in the first block to view information for similar/identical names.

3.

To view detail of another record, F7 in SOAIDNS and retype your query in the first block.
Press F8 to execute. You may now scroll the list of names viewing details.
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7.7. Object Search
This feature helps you locate Banner forms.
1.

Select Object Search from the File Menu.

2.

Type part of the form name or a word that describes the form.
Use the wildcard (%) and type the first character of each word in the description in upper
case; this search is case sensitive (if you enter part of the name, it will default to all
uppercase)

3.

Press the F8 key (Query).

4.

Your results will appear. Double-click on a form name in the name field
to open the form.
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8. Personalize My Banner
8.1. Personalize Banner INB window colors

STEP

ACTION

1.

Choose Preferences from the File Menu.

2.

Under User Interface Color Settings you will see several sets of fields that
include Description, Default Value and User Value. Each group of three entries
controls the color of a single screen element.
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Personalize Display Colors (continued)

STEP

ACTION

3.

To change a color, look for the User Value field in
one group. Click the arrow icon
next to the
field to display the color picker.

4.

Click a color swatch to select it, and click OK.

5.

Continue with colors of other screen elements.
Experiment with colors to improve contrast for
reading, or ease eyestrain by adding a pale green
background.

6.

Save the changes by clicking the Save icon
then Exit the form by clicking
in the icon bar.

7.

These changes take effect immediately.
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8.2. Display Form Names in the General Menu

STEP

ACTION

1.

Choose Preferences from the File menu.

2.

Under Display Options, make sure the check box is checked for Display Form Name on Menu.

3.

Save by clicking the Save icon
icon bar.

4.

You must Exit and restart Banner for this change to take effect.
See below for what the general menu now looks like when you browse:

, and Exit the Preferences form by clicking the

in the
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8.3. Bookmark Forms in the My Banner Folder

When you are in a form that you would like to add to the My Banner folder,
simply right-click the mouse and a pop-up box will appear. Choose Add to Personal Menu. The next
time you sign into Banner, the form will be in your My Banner folder.
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9. Query Almost Any Banner Form

Not all forms are useful to query. You’ll generally want to query forms that have few fields, but report
many rows (‘window blind forms’) or instances of data, for example:
1. Viewing students enrolled in a single class section (SFASLST)
2. Seeing student account transaction entries (TSAAREV)
3. Looking up all courses in a single subject.(SCASRCH)
4. Viewing all buildings on all campuses. (SLABQRY)
General Instructions for performing a Query
1. Almost every form in Banner allows query.
2. Not every field in a form can be queried.
3. The F7 key hides form data.
4. Type query data to be matched into a blank field or fields.
5. The F8 key executes the query, retrieving all records
that match what you typed.
6. You can query on more than one field simultaneously.
(But remember that some fields do not permit query.)
7. Looking doesn’t hurt in Banner – if the query is unproductive, try again.
8. To clear a query and return to the original view, press F8 twice.
Describe what you wish to see more of – Banner will retrieve all records that match the exact
information you type.
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Query Example

STEP

ACTION

1.

Open form TSAAREV, which displays multiple terms of transaction entries.

2.

Look up a single account record by searching an ID or name in the key block.

3.

Next Block

4.

Press F7. All the entries disappear, as seen above.

5.

Think of your question. What do I want to see?

(ctrl-PgDn) to display the entries.

Show me...

You Type

Transaction entries for Fall 2015 term.

F7, 201580 under Term, F8

All Cash payments ever made.

F7, %Cash% under Description, F8

A balance of $3,245.92.

F7, $3,245.92 under Balance, F8

A balance of less than $50 during Summer term 2014.

F7, <50.00 under Balance,
201460 under Term, F8

Notes: Some fields may not allow query. In TSAAREV, you cannot query Charge or Payment.
The character wildcard is %
You can use < and > in numeric fields for greater than $50.00 : >50.00
There may be letter case issues on some forms, for example in TSAAREV,
Descriptions are UPPER CASE for 2007 and earlier entries, and
Mixed Case for 2008 and later entries.
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10. Create a QuickFlow (Banner Macro)
A QuickFlow is a macro to page quickly through multiple Banner forms.
If you must perform a repetitive procedure, like updating the codes for a hundred students, on three
different forms per student; take a few minutes to build a QuickFlow. It’s fast to set up a QuickFlow,
and doing this will save you time opening the forms.

10.1. Name and Save the QuickFlow

STEP

ACTION

1.

Open form GTVQUIK, and select Record menu – Insert or icon.

2.

An empty row will appear, as seen above.

3.

Type a Code and a Description, then Save

and Exit

the form.

Notes: Please name your code using these first letters according to your unit:
B for Bursar
A for Advancement
I for Intl Affairs
R for Registrars

4.

F for Finance
C for Acad. Personnel
M for Admissions

S for Financial Aid
H for Human Resources
P for Provost

Open form GUAQUIK, and type the name of your QuickFlow in the field of the same name, or
click the Option List icon
to search for a QuickFlow name.
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5.

Click Next Block
(Ctrl-PgDn). You will list the forms you want in the QuickFlow under the
Current Forms column.

6.

Simply type in the desired form names in the order that they should open.

7.

Or search the list of Available Forms.
When you find a form you want under Available Forms, click it to highlight, and click the move
icon
to copy it to your list of Current Forms.

8.

The QuickFlow will open the forms in the order that they are listed under Current Forms. If
you listed a form you don’t want, remove it by clicking the removal icon.

9.

If you left a form out, highlight the row where it should be and select Record menu – Insert or
icon
to get a blank row.

10.

Did you write down your QuickFlow name?
Save
and Exit
the form.
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10.2. Run a QuickFlow

1.

To run a QuickFlow, select File menu – QuickFlow

2.

The QuickFlow run form GUAQFLW will open. Type your QuickFlow name, or click
search for your QuickFlow

3.

When you’re ready to begin, click
for searching or data entry.

4.

before you Exit.
If you are entering data, be sure to Save
When you Exit, the next form in the list will open.

5.

When you exit the last form in the list, you’ll see the Quick Flow run box.
You can
another round of forms, or r
to stop.

to

. The first form from your list will open, ready
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11. Banner Access Requests
There are many modules of the Banner system, and numerous additional systems which interact with
Banner. To obtain access to these systems, the Data Security Administrator for your department must
place a request on your behalf.
You or your supervisor must contact your DSA whenever you need additional system access,
and when your duties change such that access is no longer needed.
Look up the Data Security Administrator for your department here:
http://www2.kent.edu/is/security/systemsaccess/upload/deptsecadminlist1.pdf

Banner System

Self-Service (FlashFast)
Portal (FlashLine)
Workflow

Banner INB

“Bolt-on” Systems
Cognos
Infosilem
Encampus
DCU
Other
systems
which link
to Banner

Page- 32 -

Banner INB Navigation & Basic Features rev. 12/15

Page- 33 -

Fold on dotted line, trim and laminate to use as a reference strip on your keyboard.
Key
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F1

F2

Help
Display

Shift

Error

Options

F3

F4

Duplicate

Duplicate

Field/Item

Record

Count
Query
Select

Hits

F5
Go To

F6

F7

F8

Insert

Enter

Execute

Record

Query

Query

Clear

Clear

Remove

Record

Block

Record

F9

F10

List

Save

Rollback Print

Show
Ctrl

Keys

----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------Key

q

U
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Page Dn

Previous
Record

Next
Record

Shift
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Ctrl

Cancel Query

Field Clear

Previous
Block

Esc

Tab

l

Left Mouse Double Click
On date field = calendar

Cancel
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p

Help
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Scroll Up
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